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Copyright
Documentation
©2017 Allworx Corp, a Windstream company. All rights reserved. No part of this publication may be 
reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, 
mechanical, photocopy, recording, or otherwise without the prior written permission of Allworx Corp.

Software
Software in this product is Copyright 2017 Allworx Corp, a Windstream company, or its vendors. All 
rights are reserved. The software is protected by United States of America copyright laws and 
international treaty provisions applicable worldwide. Under such laws, the licensee is entitled to use 
the copy of the software incorporated with the instrument as intended in the operation of the product 
in which it is embedded. The software may not be copied, decompiled, reverse-engineered, 
disassembled, or otherwise reduced to human-perceivable form. This is not the sale of the software or 
any copy of the software; all right, title, ownership of the software remains with Allworx or its vendors.

Warranty
This warranty shall not apply to any products to the extent the defect or non-conformance is due to (A) 
accident, alteration, abuse, misuse, or repair not performed by Allworx, (B) storage other than 
specified, (C) failure to comply with applicable environmental requirements for the products.

Environmental Conditions
Allworx servers and phones 

Operating:
Temperature
Relative Humidity

+5° to 40° C / +41° to +104° F
5 to 90% (non-condensing)

Storage:
Low Temperature Point
High Temperature Point
High Relative Humidity Point

-40° C / +40° and any convenient humidity
+66° C / +150° 15% RH
+32° C / +90° 90% RH
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Trademarks
The following trademarks are owned by Allworx:

Revision History

Allworx® Verge™ IP phone series
Allworx® 92xx™ IP phone series
Allworx® Verge™ 9308
Allworx® Verge™ 9312
Allworx® Verge™ 9318Ex

Allworx® Reach™
Allworx® Reach Link™

Allworx® Interact™
Allworx® Interact™ Professional
Allworx® Interact Sync™

Allworx® View™
Allworx® View™ ACD

Allworx® OfficeSafe™
Allworx® Migrate™

Allworx® Connect™ servers
Allworx® Connect™ 731 server
Allworx® Connect™ 536/530 server
Allworx® Connect™ 536 server
Allworx® Connect™ 530 server
Allworx® Connect™ 324/320 server
Allworx® Connect™ 324 server
Allworx® Connect™ 320 server

Revision Date Description

A 2-FEB-2017 New Release
B 2-MAR-2017 Updated Contacts Window graphic.

Updated Call History listing management.
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Chapter 1  Introduction
Allworx Interact™ provides Windows PC users an intuitive, configurable user interface for controlling 
an Allworx IP phone. There are two versions of Interact:

• Interact, a free application available to any Allworx user, displays the inbound caller’s name and 
number in a discrete pop-up, allowing the user to view and answer incoming calls from the PC.

• Interact Professional, a per-user licensed application, adds multiple active windows for current 
calls, parked calls, call history, dial pad, system and contacts. The Contacts window provides 
contact information, Allworx user presence, availability status, and favorite status. With Interact 
Professional, users can click once to dial, transfer, or record calls.

1.1 Equipment Requirements
The table below indicates a list of all equipment and requirements necessary to perform all operations 
identified in this document.

Equipment Requirements
PC •  Running OS described below:

•  RAM minimum: 2 GB 
•  Monitor resolution: 1024 x 768 (XGA)
•  Interact or Interact Professional application 
•  Interact Sync 
•  Internet connection 
•  Microsoft .NET Framework 4.5.1
•  Allworx username and password

Allworx server •  Allworx System Software Version 8.2 (recommended) or 7.5.9.4 (minimum) NOTE: Not all Interact 
Professional features will work with Allworx System Software 7.7 and lower.

•  IP Address or DNS name Allworx server
•  Feature key for Interact Professional (not required for all operations in this document)
•  Feature key for Interact Sync (for Allworx System software 8.1 and lower)
•  Feature key Automatic Call Distribution
•  Visibility to the Allworx View Server (also requires the View CDR function key - minimum)

Allworx IP phone

•  Windows 7 32-bit SP1 •  Windows 8 32-bit •  Windows 8.1 32-bit •  Windows 10 32-bit
•  Windows 7 64-bit SP1 •  Windows 8 64-bit •  Windows 8.1 64-bit •  Windows 10 64-bit
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1.2 Product Comparison
Interact Interact Professional

Call Handling
Answer / Ignore / End / Place on hold X X
Transfer / Park / Conference X
Interact Features
Access to the Allworx system directory, call history, and contacts X
Access to Microsoft® Outlook® application X
Access to application settings Limited X
Access to handset call history X
Requires Allworx System Software 7.7 or later

Access to call queue status1 X
Access to call queue agent status (call supervisors only)1 X
Wipe current device X X
Change Allworx Password X X
Intercom call X
Call queue features1 X

Requires Allworx System Software 8.0.7.6 or later
Change Allworx PIN X X
Record All X
Access to agent login features1 X
Launch the Allworx View application2 X

Requires Allworx System Software 8.0.8.6 or later

Interact Sync3 X
Requires Allworx System Software 8.1

Five- and six-digit extension dialing X
Requires Allworx System Software 8.2

Contact Support4 X
Bluetooth Support5 X
Call Handoff5 X

1 Requires the following:
         Allworx Automatic Call Distribution feature key.
         User assigned as an agent to one or more call queues.
         Handset with an ACD PFK assigned.
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2 Requires the following:
         Allworx View CDR feature key.
         Connection between the Allworx server and the View server.
3 Requires the following:
         Interact Sync feature key (one feature key enables the feature for all Allworx users)
         Microsoft Lync 2013 or Skype for Business 2015 or 2016 installed
         Microsoft Outlook 2010, 2013, or 2016 installed
         Google Chrome™ version 41.0.2272 (minimum)
         Mozilla Firefox® Version 38.0 (minimum)

4 Requires the following:
         Personal Contact management requires an Allworx Connect series server

5 Requires the following:
         Verge 9312 IP Phone

Interact Interact Professional
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Chapter 2  Setup
This chapter describes how to install the Interact and Interact Professional applications, and then how 
to log in to the Interact Professional application.

2.1 Installation Checklist
Follow the order of the steps for a successful installation. For more detailed information, click the link 
in the Installation Guide Link Column.

2.2 Install and Log In
To install the application:

1. Navigate to http://get.allworx.com/interact/ for the downloadable version of the application. 

Step Description Installation Guide Link
1 Install the Microsoft .NET Framework version 4.5.1 for operating 

systems Windows 7 and earlier.

Download and Install the Interact Application
2 Download the Interact application from

http://get.allworx.com/interact/.
For more detailed information, see “To install the 
application:” on page 5.

3 Double-click the downloaded installer.

4 Accept the End-User License Agreement.

5 Configure the application shortcuts.

6 Click the Launch Interact checkbox, and then click Finish to launch the 
Interact or Interact Professional application.

Log in to the Interact Application
10 Launch the Interact application For more detailed information, see “To log into 

the application:” on page 6.11 Enter the Allworx username and password. 

12 Enter the Allworx Server IP address.

13 Click Login.

Note: Installing the Allworx Interact application requires Microsoft .NET Framework version 4.5.1 for operating systems 
Windows 7 and earlier. 

Note: The Interact application supports Terminal Services/Remote Desktop Services on Windows Server 2008, Windows 
Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2 using the Enterprise installer. The Enterprise 
installer also supports deployment through Group Policy Objects.
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2. Double-click the download installer. The Interact Setup Wizard dialog box opens. Click Next to 
proceed.

3. Accept the End-User License Agreement, and click Next. Select an Interact Sync setup option:

4. Click Next. Configure the application shortcuts by checking the box.

5. Click Next. The Ready to Install dialog box opens. Click Install to begin.

6. Click Yes at the User Account Control window, if prompted.

7. Click the Launch Interact checkbox, and then click Finish to launch the application.

To log into the application:
1. Launch the Interact application.

2. Enter the Allworx username and password. Enter the Allworx Server IP address. If the IP address 
is unknown, click the Find Server IP button.

To add the Allworx Server IP:
• Ask the Network/System Administrator responsible for client PCs on the network the IP 

address of the server, and enter the IP address manually.
• Ask the Allworx administrator to add a firewall exception on the workstation for the 

Interact application.

3. Click Login.

Do not install Interact Sync. I will install it 
later if I need it. 

Bypasses the Interact Sync installation step. This is the default setting.

 Install Interact Sync now (Administrator 
access required.).

Installs Interact Sync. Installing this feature requires:
•  Interact Sync feature key (one feature key enables the feature for all 

Allworx users)
•  At least one of:

•  Microsoft Lync 2013 or Skype for Business 2015 or 2016 installed 
•  Microsoft Outlook 2010, 2013, or 2016 installed
•  Google Chrome
•  Mozilla Firefox

Create a shortcut for Interact on the desktop Places a start up icon on the computer desktop. User double-clicks to 
activate application.

Start Interact automatically when I log in Log in to the computer, and Interact automatically initiates.

Interact The application icon is visible in the Windows System Tray.
Interact Professional The application opens.
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After log in, one or more notifications may display: 

4. Download the supporting documentation from http://get.allworx.com/Interact. 

5. Place a test phone call. See “Manage Calls” on page 15 for more information. 

2.3 Change the Allworx Password or Allworx PIN
Initiate a request to change the client login password or PIN. Users must supply both old and new 
passwords or PINs during the request. The new password or PIN must match the Allworx System 
Software requirements.

To change the login password or PIN:
1. Log in the application, and then locate and click:

2. Enter the required information, and then click OK. A notification displays indicating the request 
was successful. Click OK to return to the application.

Install Interact Sync Displays when the Interact Sync option is not installed and to inform users the additional benefits 
of installing Interact Sync to use with Interact Professional. Select an available option. 
Recommended: Install Interact Sync now (Administrator access required).

Update is available Displays when there is an Interact application upgrade available. 
Click Yes to update the application or click No to continue.

Handset Selection 
dialog box

Displays if the user has multiple assigned handsets. 
Click the drop-down arrow to select an available phone from the list. Click OK to continue to log 
into the server.

Change password Displays if the Allworx administrator requires the use to change the current Allworx password. 
Follow the prompts to change the current password.

Set your user image Displays when the logged in user does not have a contact image.
Click Yes to update the contact image or click No to continue.

Sync contacts with 
Outlook

Displays the first time the Interact Professional user logs in to synchronize Outlook contacts with 
Personal Contacts.
NOTE: this is on available on Verge IP phones using a Connect server.

New Outlook contacts 
found

Displays when the Interact application has found new Personal Contacts in the Outlook application. 
NOTE: this is only available on Verge IP phones using a Connect server.

Option Interact Interact 
Professional

Interact Icon in the Windows System Tray > Settings and select: Change 
Password... or Change PIN...

X X

Application Options menu > Settings and select: Change Password... or Change 
PIN...

X
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Chapter 3  Overview
The Interact application enables placing a call, answering a call, placing a call on hold or ending a call. 
The Interact Professional application has all the same capabilities as the Interact application as well as 
transfer, park, or conference a call. Additionally, the Interact Professional application enables access to 
call history, queue status, Allworx Contacts, and Personal Contacts. Each window is described in more 
detail later in this User Guide.

The Interact Professional application uses visual cues for call status and User Contact presence, 
availability, and favorite status. Interact Professional Screen example:

Both the Interact and Interact Professional application display a small pop-up box in the lower, right 
corner of the computer screen when there is an incoming call. Click:

Answer Accepts the call.
Ignore Stop the ringing of the incoming call, and dismisses the dialog pop-up.

Station Appearances

Active
Window

Action
Area

Slide-to-
Hide Open

Windows

Call Recording

Presence Setting

Application Settings Menu

Mute

Do Not Disturb

Caller ID Name/Number
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Use the Interact Professional application to view one or more windows. Each window has specific 
information:

The Interact Professional main window provides flexibility in customizing windows to accommodate 
personal preferences. Interact Professional users can:

Window Description
Active System Calls Displays all current, active calls on the Allworx server. Click the column heading to sort the calls. The sort 

toggles between ascending and descending order. The windows displays:
•  call start time.
•  call duration.
•  originator caller ID.
•  destination call ID.
Click the Slide-to-Hide window tab to view or hide the window.

Agent: <name> Enables agents to log in to or log out of call queues or identify a busy status.
Call History Displays the previous call information such as Caller ID name/number, date and time of call, and call status.
Contacts Displays:

•  Allworx directory contacts.
•  Personal directory contacts from the user’s Microsoft Outlook application.
•  Allworx system contacts.

Current Calls Displays the active calls of the user. Click the Slide-to-Hide window tab to view or hide the window.
DialPad Dial numbers from the PC. Click the Slide-to-Hide window tab to view or hide the window.
Outside Lines Displays all line appearances available to the handset. Outside lines: that are in-use are solid red.

Click the Slide-to-Hide window tab to view or hide the window.
Parked Calls Displays a view of the calls in the Parking Orbit. Click the Slide-to-Hide window tab to view or hide the 

window.
Queue Status Displays the current ACD and Call Queue status as well as provides a shortcut to the View application. All 

assigned agents can view the queue information. A queue supervisor can see agent status.
Click the Slide-to-Hide window tab to view or hide the window.

Slide-to-hide tab Click the Slide-to-hide tab opens the window. Click the Unpinned active icon to keeps the window 
open. The window is available to undock from the main application window.

Pin or Unpin Clicking the Pin active icon for each window keeps that window visible while docked in one of the 
slide-to-hide panels. 

Resize Open each window within the main application screen and manage the windows size without using 
valuable computer screen space. 

Undock or dock Place the windows on top or under the main application menu window (maximized applications 
can obscure the view).
Undocked windows Detaches the current window from the main application screen for 

custom size and placement. All windows close when exiting the Allworx 
Interact ProfessionalTM application and open in the same location when 
relaunching the application. 
To undock the window:
1.  Pin open the windows prior to undocking the window, see above. 
2.  Double-click or click and drag the title bar of the application window.
3.  Move and adjust the window.
Page 10 866.ALLWORX * +1 585 421 3850
www.allworx.com

Version: B Revised: March 8, 2017



Allworx Interact and Interact Professional Version 3.x User Guide
3.1 System Tray 
The Interact and Interact Professional applications display in the Microsoft Windows system tray 
(lower, right corner of the PC screen). Click the Interact icon to select one of the configuration options. 
See “Settings” on page 24 for more detailed information about each option. The available options are:

Undock or dock 
(con’t)

• Show Active Call window or Hide Active Call window*
• Update (only displays if a software update is available)
• Options...
• Change password...
• Change PIN...
• Reset UI configuration*
• Launch Allworx View...*
• Find out more...
• About...
• Logout <username>...
• Exit
* Available on Interact Professional only

Docked windows Returns the window back to the main application window.
To dock the window:
1.  Double-click the window title bar or click and drag the window back 

to the main application window.
2.  Drag the window to one of the placement targets shown on the 

application.
Shortcut: To return the undocked window to the original, docked 
position, double-click the undocked window title bar or window header.

X Makes the window invisible in the docked or undocked state. To make 
the window visible, navigate go to the Settings menu. See “Settings” on 
page 24 for more information.

Sample window 
placement options
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3.2 Icons
The Interact Professional application uses icons to navigate the application, view the status of a call or 
User Contact, and manage calls. The presence status icons and availability status are applicable to User 
Contacts only.

3.2.1 Navigation Icons
Navigation icons direct the user to different windows or menus to access the features available within 
the Interact application.

3.2.2 Status Icons
The status icons provide a visual cue of contact type, presence status, and call status.

3.2.3 Action Icons
The action icons enable customizing the Interact Professional application or using the application 
instead of the Allworx phone. Click the icon to activate.

Active Calls Window Agent: <name> Window Current Calls Window

Dialpad Window Outside Lines Window Parked Calls Window

Queue Status Window Options New Interact software available.

Red corner indicates an Allworx 
contact.

Contact favorite. Contact is not a favorite.

Presence Status - On Business Trip. Presence Status - Busy. Presence Status - At Home.

Presence Status - At A Meeting. Presence Status - Away. Presence Status - On Vacation.

Presence icon - Unknown. Call Status - Incoming call or call 
answered elsewhere

Call Status - Outgoing call, no 
answer.

Call Status - Incoming, missed call. Call Status - Outgoing phone call.

Closes window within the 
application. Sets an undocked 
window to invisible. See “Settings” 
on page 24 to reactivate window.

Pinned window. Window is 
available for undocking.

Unpinned window. Window 
is available for Slide-to-Hide 
option.

Do Not Disturb Inactive Do Not Disturb Active Mute Inactive

Mute Active Pause Call Recording. Resume Recording.
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3.3 Wipe Current Device
The Wipe Current Remote Licenses feature enables the Allworx administrator to remove all login 
credentials and voicemail information for a lost or stolen remote device. Additionally, this feature 
disables the device from sending and receiving phone calls. This feature requires the Allworx 
administrator to change the user password. 

To use the Interact application after receiving a wipe command, log in using the current credentials 
and the new password provided by the Allworx administrator. See “To log into the application:” on 
page 6 for more information. 

3.4 Interact Sync
Interact Sync is a customizable plug-in for Interact Professional that enables click-to-dial capabilities 
between Interact Professional and installed versions of Lync 2013, Skype for Business 2015 or 2016, 
and Microsoft Outlook applications as well as Google Chrome and Mozilla Firefox web browsers. 
Additionally, Interact Sync supports synchronization between Allworx Presence and Lync or Skype for 
Business Availability, Microsoft Outlook meetings, and the Allworx phone.

For more information, see “Interact Sync” on page 49.

End Call Recording. Begin Call Recording. Call History and Contacts 
Window - Search

Call History and Contacts Window 
- More Options

Contacts Window - Add Contact Contacts Window - Single 
Column Display

Contacts Window - Multiple 
Column Display

Contacts Window - Name/Favorite 
Status Display

Dialpad - Backspace

Dialpad - Place a phone call. Click 
twice to redial the last number.
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Chapter 4  Manage Calls
Use the Interact and Interact Professional applications to manage the incoming and outgoing phone 
calls using a PC.

To avoid disconnecting a call when answering an incoming call, configure the Allworx handset. 

4.1 Place a Call
Use one of the following options to place a call:

To place a call using the handset:
1. Pick up the handset or press the handset speaker phone soft key.

2. Dial a number. After dialing the call, the application displays a pop-up with the Cancel button. 
Press the Cancel button to stop placing the call.

To place a call using the Call History or Contacts window:
Locate a listing in the window, and then select by double-clicking the listing or right-clicking the listing 
and selecting Dial or Intercom.

Feature Interact Interact Professional
Place a call X X
Answer a call X X
Place a call on hold X X
End a call X X
Intercom call X

Phone Phone Navigation
92xx IP Phones CONFIG > Preferences > Auto On Hold. Select Enabled and exit the menu. When prompted to 

Save to Flash, press the Yes soft key.
Verge IP phone series Settings > Phone Preferences > Call Handling > Auto On Hold. Select Enabled. Press Back to 

return to the Settings screen and Back to return to the Idle screen.

Option Interact Interact Professional
Handset X X
Call History Window X
Contacts Window X
Dialpad Window X
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To place a call using the Dialpad window:
See “Dialpad” on page 45 for more information.

To place a call using Lync or Skype for Business:
Open the Lync or Skype for Business application and do one of the following:

• Right-click a main contact listing to display the context menu (example uses Skype for Business) 
and select Allworx Dial...
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• Click the “…” menu on a conversion window (example uses Skype for Business) and select 
Allworx Dial....

• Click the participant list and then right-click the user (example uses Skype for Business) and select 
Allworx Dial....
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4.2 Intercom Call
The Intercom feature displays if the Allworx phone supports the feature. If the call appearance is 
currently in use, the Interact Professional application hides the option when using the right-click menu. 
If all other default call appearances are unavailable, the Interact Professional application uses the 
Intercom appearance.

To place an Intercom call (option 1):
1. Open the Call History or the Contacts window, right-click the listing, and select Intercom.

2. Wait for the tone accompanied by a single ring. The Allworx handset on the receiving end 
automatically answers the call (default). Intercom calls to external phone numbers ring as a 
normal call. Begin speaking.

To place an Intercom call (option 2):
1. Locate the Station Appearance, click the Default Line drop-down arrow, and select Intercom.

2. Double-click a listing in the Contacts or Call History window or use the dial pad. Begin speaking.

4.3 Answer a Call
The following notifications display on the PC screen when there is an incoming call:

To answer a call from the pop-up:
For incoming calls, a pop-up displays the caller ID name/number and management options. Click:

To answer a call in the Current Calls window:
For incoming calls, the Current Calls window displays call information and management options. 

Notification Interact Interact Professional
Pop-up notification X X
Current Calls Window opens X

Answer Accepts the call.
Ignore Silences ringing and dismisses the dialog for that call. This is the same as pressing the Allworx phone Silent softkey.

Current Calls Window State
Unpinned The Current Calls window opens (auto pins), and then automatically closes the window when the call ends. 
Pinned The window does not close when the call ends.

Displayed Information
Incoming call listing •  Status icon/call details.

•  Caller ID name and number.
Call Notification Pop-up indicating an incoming call with the caller ID name and number.
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To pick-up another user’s call from the Contacts window:
For incoming calls, the contact flashes red. Right-click the contact and select Answer from the 
drop-down menu.

4.4 Place a Call On Hold
The Hold feature enables temporarily interrupting the connection between the callers without 
disconnecting the call. 

To place a call on hold:

4.5 End a Call
Click the End Call button in one of the following options:

Call Management Options
Answer Displays the call in the Current Calls window and accepts the call.
Ignore Displays in the Current Calls window and silences ringing. Click Answer to retrieve the call. This behavior is 

the same as pressing the Allworx phone Silent softkey.

Hold Feature Interact Interact Professional
Privacy Hold Click Hold in the InteractTM pop-up (default is the 

lower, right-hand corner of the computer screen).
Click Hold in Current Calls window. The call 
listing displays the following information: 
•  status icon/call status.
•  call duration.
•  caller ID name and number.
•  End Call and Resume buttons.

Shared Call Appearance 
Privacy Hold or 
Shared Hold

Click the Hold drop-down list button in the 
InteractTM pop-up to select the preferred option. The 
default behavior is Shared Hold.

Click the Hold drop-down list button in the 
Current Calls window to select the preferred 
option. The default behavior is Shared Hold.

Resume a held call. Click Resume in the Interact pop-up. Click Resume in the Current Calls window.
Disconnect the current call Click End Call in the Interact pop-up. Click End Call in the Current Calls window.

Option Interact Interact Professional
Pop-up notification X X
Current Calls window X
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Chapter 5  Status Bar
This information applies to the Interact Professional application only. Use the Interact Professional 
status bar to:

• use the do not disturb (DND) and mute features.
• manage the call recording feature.
• use station appearances to access a phone line.
• set the user presence. 
• adjust the application options.

5.1 DND (Do not Disturb) 
When activating the DND feature the handset connected to the application does not ring. However, 
users can continue to place calls from the application or phone. 

5.2 Mute
When activating the Mute feature on an active call, the user at the other end of the call does not hear 
the conversation. 

To activate DND Click the DND button ( ). 
•  All calls follow the next step in the active call route.
•  It is possible to activate the DND option during an active call. Doing so activates the feature for 

subsequent incoming calls.
To deactivate DND Click the DND button ( ) a second time. 

To activate Mute Click the Mute button ( ). 
To deactivate Mute Click the Mute button ( ) a second time. 

Mute

Do Not 
Disturb

Caller ID name and NumberPresence Settings

Options Station Appearance

Call Recording
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5.3 Call Recording
The call recording feature enables starting, pausing, resuming, or stopping the call recording of the 
current, active call (including conference calls). During the active call the Interact Professional 
application provides a status indicator showing that the recording state: active or paused. When a user 
places a call on hold, the call recording automatically pauses. The recording stops automatically when 
parking transferring, or ending a call and automatically resumes the call recording when the user 
resumes the call. Users can pause and resume the call recording manually of any active call.

The Interact Professional application stops the call recording when using a Shared Call Appearance to 
place the call on a public or bridged hold. Private hold requests work the same as a regular 
appearance, if the appearance is a shared call appearance. When resuming a previously paused 
recording, the feature inserts a beep/tone into the recording as a marker and displays a recording flag.

The Record All feature captures audio files from the time the Interact Professional user answers the call 
or launches the application during an active call automatically when the feature is enabled. While the 
Record All feature is active, the recording features – pause/resume/stop – are available, as usual. If 
there are no available audio channels for recording, the Interact Professional application displays a 
pop-up message. When launching the Interact Professional application during an active call and the 
Record All option is enabled, the application inserts three beeps to signal the start of the call recording 
and there was previously unrecorded information from the phone call.

The Interact Professional application automatically pauses the recording whenever placing the active 
call on hold, and then automatically continues recording after resuming the call on hold or ends the 
recording if the caller on hold hangs up.

During a phone-hosted conference call, each active call has its own recording file. The recording 
feature stops when ending an active call in the conference call or ending the conference call. To 
change the Call Recording File Location, Record All capability or Volume, see “Recording” on page 26.

The Allworx administrator must enable the Call Recording feature, and then the Allworx phones 
support the following call recording instances:

Phone-hosted 
conference calls 

OR call recording

Call Recording a 
three-way 

conference call
Call Supervision

Call Recording a 
four-way 

conference call
9202E phone X X
9204 phone X X
9212 phone X
9224 phone X
Verge series X X X
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To record an active call:

5.4 Station Appearance
The selected station appearance remains active until changed by the user.

To select the call type for the outbound call:
1. Click the drop-down arrow. The list of available options display. Select the option to use. The 

option stays active until a different option is selected. 

2. Place a call by using one of the following options: 

3. Begin talking using the designated Allworx handset, and then click End Call when finished. 

5.5 Presence 
The presence icon shows User Contact availability status. A presence other than In Office displays the 
presence status icon for the selected presence. See “Icons” on page 12. 

Option Description
Start ( ) Begins recording the conversation. To start the recording, select an option:

•  Click the action icon in the Device Status area.
•  Navigate to Current Calls > More > Start Recording.

Pause ( ) Temporarily stops the recording. The icon changes to the Resume Recording action icon, and the Interact 
Professional application interrupts recording the conversation.

To pause the recording, click the action icon in the Device Status area.

Resume ( ) Restarts recording the conversation. The icon changes to the Pause Recording action icon, and the Interact 
Professional application starts recording the conversation.

To resume the recording, click the action icon in the Device Status area.

Stop ( ) Ends the recording, and the Interact Professional application saves the file. To stop the recording, select an 
option: 
•  Click the action icon in the Device Status area.
•  Navigate to Current Calls > More > Stop Recording.

Default Line Place an internal or external phone call.
<other available line 
appearance>

Place a call using specific line appearance .

Shared Call Appearance Place a call using a specific shared call appearance line.
<Bluetooth enabled device> Place a call using the Bluetooth appearance. Requires the Verge 9312 IP phone.
Intercom Place an intercom call only to Allworx directory contacts.

•  open the application dialpad to dial the number. •  double-click a listing in the Contacts window.
•  use the phone dialpad. •  double-click a listing in the Call History window
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To change the status:
1. Click the drop-down arrow next to the presence status word.

2. Select an option from the drop-down list. 

5.6 Settings
The Settings menu enables managing the Interact or Interact Professional application. Click the ( ) 
navigation icon to access the settings, and then select one of following options:

5.7 Update the Options
The Options feature enables configuring the Interact or Interact Professional application. After opening 

•  In Office •  Busy •  On Business Trip •  At Home
•  On Vacation •  At A Meeting •  Away

Visible Windows* Changes the current window view. Use this setting to show or hide windows. When changing slide-to-hide 
windows to visible, pinned is the default behavior.

Show Active Call 
Window / Hide Active 
Call Window*

Displays or hides the incoming, active call pop-up window, respectively

Update Application Requests an upgrade from the portal, if available.Click to begin the update.
Update Interact Sync* Displays only if an upgrade is available.Click to begin the update.
Options... Click the tab to adjust:

See “Update the Options” on page 24, and then click:

Change password... Enables the user to update the current Allworx password. See “Change the Allworx Password or Allworx PIN” 
on page 7 for more information. 

Change PIN... Enables the user to update the current Allworx PIN. See “Change the Allworx Password or Allworx PIN” on 
page 7 for more information. 

Reset UI configuration Resets the application display settings to the factory defaults. Click OK to accept the request.
Launch Allworx View...* Opens the View application in the default web browser window for more detailed statistics about queues, 

agents, and calls. Manage the View application as defined in the Allworx View Application User’s Guide. 
Find out more... Links to the Interact Upgrade Options page.
About... Identifies the application version level, copyright, and support contact information.
Logout Signs the user out of the application; enables a new user to log in the application.
Exit Closes the application.
* Available on the Interact Professional application only.

•  Call Notification •  Recording •  External Program Link settings 
•  Contacts •  Interact Sync

Apply To view the new settings without closing the Settings window.
OK To save all changes or Cancel to ignore the changes. All changed settings persist across 

application starts (either restart or application upgrade)
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the Options menu, select a configuration tab, and then adjust the setting as necessary.

To open the Options menu: 

5.7.1 Call Notifications
Adjust the application preferences when receiving an incoming call. 

5.7.2 Contacts
Set the My Allworx directory image, manage the personal contacts from external sources, and import/
export personal contacts. 

Location Description Interact Interact 
Professional

Device status > ( ) > Options... Displays multiple tabs of available configuration options. X
System Tray > Options... Displays list of available configuration options. X X

Location Position of the pop-up notification window on the computer screen. Options include:

Opacity Slider bar adjusts the pop-up notification window transparency.
Duration Indicates the length of time the pop-up notification window displays. Options:

•  Active calls - stays open for the entire length of the active call.
•  Timed - select amount of time in seconds. (Default is 10 seconds)

Ringing Animation Behavior of the BLF appearance during an incoming call in the Contacts window. Options: include:

My Allworx directory image
Select an image to store on the Allworx server and associate with your Allworx User Contact entry. This is the image that other Allworx 
users see associated with your caller ID name/number in the directory listing.

Add an Image / Change the image Opens a file explorer dialog box. Navigate to the directory that contains the image, and 
then click Open to add the image.

Clear the image Removes the image file and returns the avatar to the contact silhouette. 

Outlook Integration
Contact integration with Outlook is 
<enabled/disabled>.

Indicates the current selected option. Select the Enable  or Disable button to change.
•  If enabled, the Interact application communicates with the Outlook application to 

monitor Personal Contacts for availability in the Interact Professional application.
•  If disabled, the Interact application removes Outlook Personal Contacts from the 

Contacts list. Additionally, the Interact Professional application does not share the 
Personal Contacts with other Allworx devices and applications.

Contact Accounts
The Interact application can display Personal Contacts on all assigned Allworx applications and devices. 

•  Lower Right (Default) •  Center •  Lower Left
•  Center •  Upper Right

•  Flash (Default) •  Pulse •  None
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After managing the My Allworx directory image or the Personal contacts from external sources, click 
Apply. After all configuration changes are complete, click OK.

5.7.3 Recording
Specify the recording storage folder, manage the Record All feature, and volume level. 

Accounts on this device Displays local the contact locations. 
•  If the account settings have not been set, click Choose.
•  If the account settings are set, click Edit to open the Edit account details dialog box.
Select one of the available options to change the contact management or click Forget 
account to remove the contacts.

Accounts on other devices Displays contact locations synchronized from other Allworx devices..
•  If the account settings have not been set, click Choose.
•  If the account settings are set, click Edit to open the _Edit account details_ dialog box.
Select one of the available options to change the contact management or click Forget 
account to remove the contacts.

Import / export personal contacts
Users can import contacts from a CSV or vCard file into the Personal Contacts, which is stored on the Allworx server. Users can also 
export the personal contacts to a file for backup purposes or to import into another application.
Import from file Prior to performing this operation, create, save, and close a .CSV file with the following 

fields: 

1.  Selecting this option opens a file explorer dialog box. Navigate to the file location, and 
then click Open. 

2.  Use the drop-down lists to select how to map the columns in the CSV file to the 
contact fields. If the .CSV file contains column headings, verify the First row contains 
column headers is checked.

3.  Click OK. A confirmation dialog box displays. Click OK to close it, and then click OK to 
close to the Option Settings dialog box.

Export to CSV file or Export to vCard file Opens a fire explorer dialog box. Navigate to the folder to store the file, and then enter a 
File name in the field. Click Save. The Successful export operation dialog box opens and 
indicates the number of exported contacts. Click OK. 

Refresh contacts Click to update the Contacts window.

Folder to store 
recordings in

The folder to store the recordings displays. 
To change the folder location, click Browse... and navigate to the new location. Click OK to set the new 
destination. The file displays in the folder starting with the Interact Professional username and the date.

Record All Capture audio files from the time the Interact Professional user answers the call or launches the application 
during an active call automatically. See “Begin talking using the designated Allworx handset, and then click 
End Call when finished.” on page 23 for more information.
Enabled - User can turn on the Record All Calls feature locally. The default is Off.
Enabled by Server Administrator - Allworx administrator turned on the Record All option on the Allworx 
server. Users cannot turn off this setting at the local level. The pause, resume, or stop icons are available.

Record volume Use the slider bar to adjust the volume of the recording. Left for a quieter recording, right for a louder 
recording.

Required Optional
•  Description OR Last Name •  First name •  Login
•  One phone number •  Middle name •  DID DNIS Name

•  DID Prompt Language
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5.8 Interact Sync settings
Configure the Interact Sync feature to call a Lync or Skype for Business contact and/or to adjust the 
presence settings. 

Click-to-dial options
Contacts in Skype for Business and Lync can have up to four associated phone numbers. This section configures the phone number to 
use.

Always prompt me for the number to dial Requires selecting the contact phone number after selecting the Allworx Dial... option.
Automatically dial the following number 
(when possible)

After selecting the contact, Interact Professional automatically dials the phone number. 
Select which number to automatically dial:

Presence Synchronization Options
Configure the ways the Skype for Business or Lync Availability along with Outlook appointments can affect the Allworx Presence and 
phone Do Not Disturb setting. 

Availability and phone calls
Check the box to enable automatically updating the Lync or Skype for Business Availability when using the Allworx phone. After the call 
ends, the Availability status returns to the previous setting. 
When I’m using my Allworx phone, modify 
my Availability 
to

Select from the following options:

Availability and Allworx Presence
Check the box to enable automatically updating the Lync or Skype for Business Availability setting with the Allworx presence setting and 
vice-versa. Additionally, scheduled meetings on the Outlook calendar update the Lync or Skype for Business application, which updates 
the Interact Professional application. After customizing the settings, the Lync or Skype for Business and the Interact Professional 
applications synchronize the Allworx presence and Availability settings.
On initial link-up: Select from the following options:

•  Copy my Availability to my Allworx Presence
•  Copy my Allworx Presence to my Availability

When I am in a call in my Skype for Business 
or Lync application and my Availability 
changes to In a call:

Select from the following options:
•  Do not change my Allworx Presence
•  Change my Allworx Presence to:

When my PC is idle for a prolonged period 
of time (typically 10 minutes) and my 
Availability changes to Away:

Select from the following options:
•  Do not change my Allworx Presence
•  Change my Allworx Presence to:

When I lock my PC and my Availability 
changes to Away:

Select from the following options:
•  Do not change my Allworx Presence
•  Change my Allworx Presence to:

•  Work Phone •  Mobile Phone
•  Home Phone •  Other

•  Available •  In a call •  In a conference call •  Be right back
•  Busy •  In a meeting •  Do Not Disturb •  Away

•  Away •  At A Meeting •  Busy

•  Away •  Busy

•  Away •  At Home •  Busy •  At A Meeting
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After configuring the settings, click:

Availability and phone DND setting
Check the box to enable automatically updating the Lync or Skype for Business Availability using the Allworx phone Do Not Disturb 
setting. When setting the Allworx phone to Do Not Disturb (DND), the Interact Sync changes the Lync or Skype for Business Availability 
to Do Not Disturb as well. 
On initial Link-up: Select from the following options:

•  Copy my Availability to my phone DND setting
•  Copy the DND setting from my phone to my Availability

When I lock my PC and my Availability 
changes to Away:

Select from the following options:
•  Do not change the DND setting on my phone
•  Enable DND on my phone

Appointments and Allworx Presence
Check the box to enable automatically updating the Allworx Presence based on new Outlook calendar appointments. 
Default Presence for calendar appointments Select from the following options:

Do not modify my Presence for 
appointments with a “Show As: value of:

•  Free
•  Tentative

Default Presence for calendar appointments Select from the following options:

Override options Temporarily disable synchronization between the Microsoft applications and Allworx 
Presence.

Locate Ignore Availability changes when I manually set my Presence to:, and then 
select the applicable option:
•  On Vacation
•  On Business Trip
•  At Home

Presence change log Display a running log of recent changes to the Allworx Presence and DND for debugging 
purposes.

OK Saves the changes and closes the Options... window.
Cancel Disregards the requested changes.
Apply Saves the changes and allows continuing to customize the Interact Sync application.

•  Unmodified •  On Vacation •  At A Meeting
•  “Show As” based (Outlook feature) •  At Home •  Away
•  In Office •  On Business Trip •  Busy

•  Unmodified •  On Vacation •  At A Meeting
•  “Show As” based (Outlook feature) •  At Home •  Away
•  In Office •  On Business Trip •  Busy
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5.8.1 External Program Link
Tie the Allworx phone into a business work flow. Specify an action for the Interact Professional 
application to perform whenever certain phone system events occur and manage existing actions to 
new requirements.

Rule 1
Rule name Enter the name of the rule in the field provided. The Rule 1 heading changes to match the entered 

description. 
Action to perform
Type of action 1.  Select an option using the radio button:

•  URL - See “To use External Program Link - URL option:” on page 30 for more information.
•  command line - See “To use External Program Link - CMD Shell option:” on page 30 for more 

information.
2.  Enter the URL or command line executable.

Macros Shortcuts to include in the command line executable. Options:
Click the drop-down arrow and select an option. Click Insert selected macro to add to the Command to 
execute section. Options include:

•  %CALLNUM% (phone number of the caller)
•  %CALLNAME% (name of the caller)
•  %DNISNUM% (DNIS number of the caller)
•  %DNISNAME% (DNIS name of the caller)
•  %COMPANY% (company name of the caller)

•  Only inserts COMPANY when the CALLNUM finds a matching contact in the personal contacts and the 
matching contact has a company assigned.

•  Automatically appends CALLNUM to the end of an API string with no macros.
•  Only inserts DNISNUM and DNISNAME values when available, otherwise the application inserts a blank.

Macro Expansion 
Options

Click the arrow to view the drop-down list. 
•  Prepend home area code to local numbers:

•  Strip the external dialing prefix from all phone numbers - Check to select, uncheck to deselect.
•  Strip the country code from all phone numbers - Check to select, uncheck to deselect.

When to perform 
this action

Check the box to enable or uncheck the box to disable the requirement when performing the command. 
Options include:

Select appearances 
(Advanced)

Enables selecting which appearances should use the defined rule. Check the box to enable or uncheck the 
box to disable. Click OK to save the request or Cancel to ignore the request.

Version 7.7 or lower
Verify the Home Area Code is available in the Dialing Plan. If there is no Home Area code, enter the 
home area code.
Version 8.0
Verify the Home Area Code is in the Dialing Plan.
•  If a Home Area Code is unavailable, enter the home area code.
•  If a Home Area Code is available, locate the Prepend the area code <area code configured on the 

server> to all local numbers line and check the box.

•  Perform on inbound calls •  Only execute if a call is answered •  Do not execute for internal calls
•  Perform on outbound calls •  Only execute if a caller is not in the 

contact list
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To use External Program Link - URL option:
1. Launch the third-party application in a separate browser window to use with the Interact 

Professional External Program Link feature. Perform an operation for the information containing 
one or more of the External Program Link macros in the Interact Professional application. 

2. Highlight and copy (Ctrl + C ) the URL from the browser window. Example: Sales Force 
application Advanced Search using phone number. www.salesforce.com/search/
SearchResults?searchType=2&str=5854210000&search=Search&sen=0.

3. Navigate to the Interact Professional application and paste the URL in the Command to 
execute field (Ctrl + V). 

4. Replace the macro information (phone number in this example) by highlighting the information 
within the pasted URL, locate the Macros line, and select the correct macro key from the 
drop-down list. Click Insert to replace the highlighted portion of the URL with the macro.

5. Repeat step 4 for each additional macro substitution within the same URL.

To use External Program Link - CMD Shell option:
Enter the following command shell script. The examples below use “C:\Program Files\CMS\ 
CMSSCREENPOP.EXE” as an example of the executable command file.

a. For a completely automated screen pop:

b. For a partially automated screen pop:

Add a new rule Add a second rule to the External Program Link. Follow the options above to enter the required information 
in the fields provided. Remember users can:
•  add as many rules as necessary. There is no number limit to adding rules. 
•  rename the rule without affecting the rule behavior.
•  reorder the rules for processing purposes.
•  use the Copy button to duplicate an existing rule, and then edit the rule separately.
•  delete rules.

The application processes the rules in the listed order and applies all rules on any given call asynchronously. 
If a call triggers multiple rules, it is possible that the application executes multiple (or all) rules 
simultaneously.

Problem solving
Try an example for 
Rule 1

Displays a sample contact and URL based on the information provided in the Command to Execute section.

Test this action now Click to verify the command is valid.
Action history Click the arrow to display the list of recently performed commands.

C:\Program Files\CMS\CMSSCREENPOP.EXE /PHONE:"%CALLNUM%" /LOGIN:<username> 
/PASSWORD:<userspassword> /LAUNCH

C:\Program Files\CMS\CMSSCREENPOP.EXE /PHONE:"%CALLNUM%" /LOGIN:<username> 
/PASSWORD:<userspassword>
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Chapter 6  Windows
This information applies to the Interact Professional application only. The Interact Professional 
application displays up to nine available windows to independently manage and customize. 

6.1 Active System Call
The Active System call window displays internal and external calls and the following call information:

Click the column heading to sort the displayed information.

To change the Active System Call window view, contact the Allworx administrator to update the user 
system-wide active calls display to: 

Start time Time of day the call began.
Duration Amount of time the call connection is active.
Originator Caller ID Caller ID starting the call.
Destination Caller ID Caller ID receiving the call.

Not Displayed The window does not display.
Brief Display (no Caller ID) Both originator and destination caller ID displays as Private
Full Display (with Caller ID) Caller name and caller ID display.

Hide Window Active Icon

Active call
information
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6.2 Agent: <name>
The Agent: window is available to Interact Professional users assigned to a call queue and have an ACD 
Appearance PFK assigned to the handset. Agents can log in or log out of call queues as well as select a 
busy status using the Interact Professional application or the handset, and then the Agent: window 
automatically updates the agent information.

To Log in or Log out of a call queue:
1. Click the Login/Logout... button. The Agent Login/Logout window opens and displays a list of 

assigned call queues.

2. Check or uncheck the box to select the call queue(s) to log in to or log out, respectfully.

3. Click in the Allworx PIN field and enter the assigned Allworx PIN.

4. Click Apply. After logging into one or more call queues, the Login/Logout... button displays a 
blue badge. The badge indicates how many call queues the agent logged in to. A red badge 
with the number 0 displays if the agent logs out of all call queues. To see the queues the agent 
has logged in to, hover the cursor over the badge on the Login/Logout button. A red flag next 
to the Allworx PIN field indicates an invalid PIN number. 

To set or clear the agent status:
After logging in to one or more call queues, an agent can set the agent status to Busy or Idle. 

Click the button displaying the agent status and select the new agent status option from the list.

Note: The Interact Professional agent cannot change the following Busy States:

Agent Busy Status
Can change to:
•  Idle -> Busy
•  Busy -> Busy
•  Wrap-Up -> Busy
•  Wrap-Up -> Idle

Login/Logout

Log in/Log out Window with 
assigned ACD Queues

Hide Window ButtonLogin/Logout Queue Badge
Red = no logged in queues
Blue = number of logged in queues

Hover over Login/Logout but-
ton to see logged in queues.Agent Selectable Status

•  Ringing •  Call On Hold •  Administration functions (i.e. handset is in use) •  On Call
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6.3 Call History
The Call History window loads the user call history when first opening the application and continues to 
provide a listing of the current call history size (Verge IP phones support 200 entries / 92xx IP phones 
support 99 entries). The window updates with each call and deletes the oldest Call History list entry as 
the application adds new entries to the list. 

Call History listings include: the caller ID (red text indicates a missed call), date/time of call, and status 
icons. Use this window to place a call, search, change the display order, or clear the call history list. 

To manage the Call History listings:
1. Locate the Call History listing and right-click. 

2. Select an option from the drop-down list: 

•  Transferred call forwarded to another recipient
•  Ended normal call ended
•  Parked <orbit number> call placed into a Parking Orbit
•  No Answer outbound call that is not answered (internal calls only).
•  Missed inbound call that rings, but it is not answered.
•  Check failed to route to an outbound call
•  Elsewhere missed inbound, picked up somewhere else, i.e., Reach Device

Dial Places a call to the listing. Shortcut: double-click the listing.
Intercom Places an Intercom call to the listing. 
Add to Contacts Opens the Edit contact details pop-up window. Enter or update the information and click OK 

to add the contact as a Personal Contact.
Delete entry Clears the Call History listing from the Call History window.
Delete all... Clears the entire Call History list from the Call History window. Answer Yes to the confirmation 

to perform this action.

Search Field Use drop-down arrow to manage:
•  Display Order
•  Search By
•  Search Preference
•  Clear History

Call History Listings
•  Caller image (if available), 

red corner indicates Allworx 
business directory contact.

•  Caller ID Name/Number
•  Call information
•  Call status 

Hide Window Icon
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To do a Search within the Call History window:
Provide criteria in the search field and locate a specific call history listing.

1. (optional) Click the drop-down arrow next to the Search field and select the Search Preference.

2. Type the search criteria in the field. The application displays the call listings matching the Search 
field information in the Call History window.

To clear the search field criteria, click the X next to the field.

To change the Call History window display order:
Select how the call history window displays the listings.

1. Click the drop-down arrow next to the Search field.

2. Select Display Order in the drop-down list, and then the preference. The Call History window 
updates the view per the selection.

To clear the call history:
Delete all listings in the Call History window. 

Locate the Call History Window, and click the drop-down arrow next to the magnifying glass. Select 
Clear History from the list.

Details... View the Call History listing details - call date/time, caller/contact ID and number, call duration, 
and network statistics. Select one of the following buttons after opening the Call History 
Details pop-up window:

All Fields (Default) Display listings with any field matching the search criteria.
Full name Display the caller ID names matching the search criteria.
Number Display the caller ID numbers matching the search criteria.
Date/Time Display listings with a date/time stamp matching the search criteria.

Name Displays the Call History listing by caller ID name.
Number Displays the Call History listing by caller ID number.
Time Displays the Call History listing with the most recent call on top. (Default setting)

Note: When performing a clear call history, this also clears the handset call history.

OK Close the Call History details window.
Add to Contacts Opens the Edit contact details pop-up window. Enter or 

update the information and click OK to add the contact as a 
Personal Contact.

Delete entry Removes the Call History listing from the Call History window.
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6.4 Contacts
The Allworx System supports four types of contacts on the Verge IP phone series:

• User and System contacts – contacts with an internal Allworx extension assigned. The Allworx 
Server Administrator manages these contacts.

• Public Contacts – system-wide contacts (formerly known as Speed Dial). The Allworx Server 
Administrator manages these contacts.

• Personal Contacts – (only available on Allworx systems with a Connect server) contacts 
managed by the Allworx user. 
• Allworx Personal Contacts

• created from the Verge IP phone, the Interact application, or a Reach device 
contact application.

• imported from a .CSV file or vCard within the Interact application.
• External Personal Contacts

• synchronized from a Reach device originating application (device app such as 
Contacts or People)

• synchronized from an account such as a Gmail email account or an Outlook email 
account.

Visual example of Contacts:
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6.4.1 Sharing Contacts
The Allworx system shares the User, System, and Public Contact types with all of the Allworx user’s 
connected Allworx phones, Reach devices, and the Interact application. Within the Reach and Interact 
Professional applications, Allworx users control sharing and synchronizing the Personal Contacts to the 
devices assigned to the Allworx user. 

Visual example of sharing contacts using a Connect server:

6.4.2 Contact Privacy
Allworx users control sharing and synchronizing the Personal Contacts to the devices assigned to the 
Allworx user on the Options > Settings > Contacts page:

• Choose which contact source accounts (e.g. Outlook) to share with your Allworx devices and 
applications.

• Disconnect a contact source account from other Reach devices.

Note: The Allworx Connect server is not a contact manager for Personal Contacts. Example: If a Personal Contact 
is available in the Reach device app (i.e. Contacts) and the same Personal Contact is available in the user’s 
email account (i.e. Gmail), the Personal Contact displays twice when viewing the contacts.
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6.4.3 Data Protection
Only the Allworx user has access to their personal contacts; the Allworx Server Administrator cannot 
access the user’s personal contacts. Allworx users can prevent others from see the personal contacts 
on their Verge IP phone by restricting access. This requires the Allworx PIN to unlock the Verge IP 
phone.

6.4.4 Managing Personal Contacts
Allworx users can manage and update Personal Contacts by using the originating device or 
application. Only the Allworx user can add, edit, or delete each Personal Contact. Allworx Server 
Administrators can delete all of a user’s personal contacts from the Connect server permanently but 
cannot limit the individual user’s number of Personal Contacts stored on a Connect server.

Example:
Jane Smith needs to update her Personal Contact, Tom Wright. Since Jane uses the Verge IP phone, 
Reach for iOS, and the Interact application, she needs to determine how she added Tom to her 
Personal Contacts. Within the Interact Professional application, Jane opens the Contact window and 
scrolls to find Tom Wright. Jane hovers the mouse over Tom and locates the Account and Devices lines 
to learn how she added Tom to her Personal Contacts. 

If the Account line reads:

• Allworx Personal: Jane added Tom Wright using her Verge IP phone. To update the contact 
information about Tom, Jane can use her Verge IP phone, the Reach application or the Interact 
Professional application.
866.ALLWORX * +1 585 421 3850 Page 37
www.allworx.com
Version: B Revised: March 8, 2017



Allworx Interact and Interact Professional Version 3.x User Guide
• Allworx User, Allworx System, Allworx Public* – The Allworx Server Administrator manages 
these contacts using the Allworx System software. 

• <email account>: Jane used her email account (such as Gmail or Outlook) to synchronize her 
contacts with her Verge IP phone. To update the contact information about Tom, Jane must do 
so in her email application.

• <Reach device>: Jane used an iOS or Android app (such as Contacts) to manage her contacts 
to her Verge IP phone. To update the contact information about Tom, Jane must do so on the 
identified device in the appropriate app.

* the only user-editable options for these contacts types are the Favorite status and the choice of 
default phone number on the Verge IP phone, Reach application or Interact application.

6.4.5 Window Overview
Use this window to view or group the contacts, designate favorite contacts, add a new Personal 
Contact, and adjust the view. Interact Professional users can place calls, search the contacts using 
specific criteria, and change the display order. 

Search Field

Groups

Hide Window Icon

Drop-down arrow to select:
•  Display Order
•  Display Visibility
•  Search By
•  Search Preference

Standard View with High Visibility Display

View increase or decrease

User Contact
•  Contact Image, if available
•  Allworx Badge
•  Contact Name/Number
•  Presence Status, if available
•  Favorite Status
•  Availability status, if 

available

Public Contact
•  Contact Avatar
•  Allworx Badge
•  Contact Name / Number
•  Speed Dial / Contact Number
•  Favorite Status

Personal Contact
•  Contact Image, if available
•  Contact Name / Number
•  Company Name, if available
•  Favorite Status

System Contact
•  Contact Avatar
•  Allworx Badge
•  Contact Name / Number
•  Favorite Status

Add new Personal Contact
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Each contact listing displays a contact photo (if available), caller ID name and number, and the favorite 
status. Personal Contacts display the company name (if available). User Contacts display icons to 
indicate a presence status for other than In Office (see “Icons” on page 12) and an availability status 
using color-coded BLF status information.

Hovering over a contact displays a pop-up window with the following information:

To change the Display Visibility within the Contacts window:
1. Click the drop-down arrow next to the Search field and select the Display Visibility option.

2. Select the High Visibility (highlights the entire User Contact Listing) or Low Visibility (changes 
the User Contact Listing text color) option.

To use the Contact groups:
Each group button adds or removes contact entries from the list. Clicking the group button toggles 
the contacts view on and off independently of the other group buttons. The group remains active after 
closing and reopening the Interact Professional application.

Color Description Color Description
Normal (Black) Handset is idle. Red (flashing) Handset is ringing. 
Red (solid) Handset is on an active call. Amber Do Not Disturb.

User, System, or Public Contact Personal Contact
•  Caller ID name and number
•  Current status
•  Presence
•  Call duration (active call only)

•  Caller ID name and number
•  Company name, if available
•  Account - the source account used to create the contact
•  Device - the device used to create the contact

Favorites Display only Favorite contacts from business and Microsoft Outlook directories.
User Display the Allworx contacts assigned an Allworx handset.
System Display the Allworx Call Monitor, Call Queue, Auto Attendant, and System Paging Zones.
Personal Display the contacts synchronized from a Reach device, the Verge IP phone, or Microsoft Outlook.

Ultra Condensed with Low Visibility Display
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To designate favorite contacts:
A blue star displays in the contact listing to indicate the contact is a favorite. To designate or remove a 
contact as a favorite, click on the star icon in the contact listing or right-click the contact listing and 
select Favorite from the drop-down list. 

To add a new Personal Contact:
Interact Professional users can add new Personal Contacts from the Contacts window. Click the new 
Contact ( ) button to open the Edit contact details dialog box. Enter the information in the fields 
provided, and then click the OK button. The new Personal Contact displays in the Contact window.

To edit or delete a Personal Contact:
Interact Professional users can edit or delete Personal Contacts that were created in the Interact 
application, Reach application, or on a Verge IP phone. Right-click the contact listing in the Contacts 
window and select: 

To adjust the contact listing display: 
Click the view adjustment icon to alter the size of the contact listing display from a single-row to multi-
column format. To identify the user status:

To place a call:
Right-click on a Contact listing and select one of the following options: 

To pick-up another user’s call from the Contacts window:
For incoming calls, the contact flashes red. Right-click the contact and select Answer from the 
drop-down menu to pick-up the call.

To specify the primary number of a personal contact: 
1. Right-click the Contact listing. Select Details... from the drop-down list. 

2. Locate the contact phone number, and select one of the available phone numbers. 

3. Click Done to save the changes.

Edit contact... The Edit contact details screen displays. Update the information, and then click OK. 
Delete contact The Delete a personal contact confirmation displays. Press Yes to remove the Allworx Personal Contact.

Smallest available view Described as the Ultra condensed view that displays a single-line entry with the username, directory contact 
icon, and the favorite status icon

Largest available view Described as the Standard view displaying two lines of information, which also includes the contact number.
A Microsoft Outlook contact has three lines of information, which includes the company name, if available.

All other views Other views vary in the display of the user name, directory contact icon, and favorite status icon. In the 
example above, shown as Condensed View.

Dial Places a call to the listing. If more than one phone number is available, select a number from the drop-down list. 
Intercom Places an Intercom call to the listing.
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To change the Contacts window display order:
Change the display order of the contacts. When changing the contacts display order, the selection 
remains active after closing and reopening the application. 

1. Click the drop-down arrow next to the search field.

2. Select the Display Order option in the drop-down list, and then the preference. The application 
window updates the view per selection.

To search within the Contacts window:
Provide criteria in the search field and locate a specific call history listing. When selecting a search 
preference, it is still active after closing and reopening the Interact Professional application.

1. Type the search criteria in the field. The application returns any contact listing containing the 
search criteria. 

2. (optional) Click the drop-down arrow next to the Search field and select the Search Preference 
option.

3. (optional) Click the drop-down arrow next to the Search field and select the Search By option. 

To clear the search field terms, click the X icon next to the field.

First Name Arranges the contacts by the caller ID first names.
Example: First name Last name.

Last Name Arranges the contacts by the caller ID last names. (Default)
Example: Last name, First name, Middle name. (Default)

Company Name Arranges the contacts by the Corporate names (from Microsoft Outlook only)
Example: Company name Last name First name

Number Arranges the contacts by the caller ID number.
Example: Caller ID number Last name First name

Contains Display the contact listings with any of the search criteria.
Starts with Display the contact listings that begin with the search criteria.

All Fields (Default) Display listings with any field matching the search criteria.
Full name Display the caller ID names matching the search criteria.
First Name Displays the caller ID first names matching the search criteria.
Last Name Displays the caller ID last names matching the search criteria.
Company Name Displays the Corporate names matching the search criteria (from Microsoft Outlook only)
Number Display the caller ID numbers matching the search criteria.
866.ALLWORX * +1 585 421 3850 Page 41
www.allworx.com
Version: B Revised: March 8, 2017



Allworx Interact and Interact Professional Version 3.x User Guide
6.5 Current Calls
The Current Calls window displays all active and on hold calls for the handset connected to the Interact 
Professional application. Additionally, Interact Professional users can place a call on hold, transfer a 
call, create a conference call, or end the active call from this window. The application automatically 
searches the Personal Contacts during a new call and displays the contact name, if the number 
matches any of the numbers in the contact number list. Listen to the call through the phone speaker, a 
headset, or by picking up the phone handset. Close the Interact Professional application without 
affecting the current phone state such as disconnecting the current call.

To place a call on hold:
See “Place a Call On Hold” on page 19 for more information.

To transfer a call in the Allworx Interact Professional application:
1. Locate the Current Calls window, and then the current phone call.

2. Click the More drop-down arrow, and then select a transfer option: 

Note: To avoid disconnecting a call, configure the Allworx handset. 
•  92xx IP phone - CONFIG > Preferences > Auto On Hold. Select Enabled and exit the menu.
•  Verge IP phone series - Settings > Phone Preferences > Call Handling > Auto On Hold. Select Enabled. Press 

Back to return to the Settings screen and Back to return to the Idle screen.

Option Description
Blind Transfer Place the call unannounced to an extension or external phone number. 
Attended Transfer Place the call announced to an extension or external phone number.
Transfer to my voicemail Place the call directly to the user’s voicemail. This option only: The call transfers immediately, 

and no longer displays in the Current Calls window. 
Transfer to voicemail Place the call directly to the another user’s voicemail.
Park Place the call in a Parking Orbit. The Parking Orbit number for a short period of time.

Hide Window Icon

Line #2 Information
•  Caller Image, if available
•  Current State
•  Caller ID Name
•  Caller ID Number
•  Call Duration
•  Call Management Buttons

Line #1 Information
•  Caller Image, if available
•  Current State
•  Caller ID Name
•  Dialed Number Identification Service: the telephone 

number dialed by the caller.
•  Call Duration
•  Call Management Buttons/Drop-down Menu
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3. Click a listing in the Contacts, Call History, or Current Call window or use the dial pad. The call 
transfers.

Transfer shortcuts:

To create a conference call: 
Set up phone-hosted conferences between three parties (3-way conferences).

1. Place the active call on hold. 

Shortcut Description
Left click and drag Blind Transfer. User clicks on the active call, and then drags the call to a listing in the Call History or Contacts 

list. Release the left mouse button to immediately connect the two calls.
Right click and drag User right clicks on the active call, and then drags the call to a listing in the Call History or Contacts window. 

After releasing the right mouse button, a drop-down list displays.
•  Blind Transfer* - Selecting this option, the application immediately connects the two calls.
•  Attended Transfer* - Selecting this option, a second call listing displays in the Current Calls window. After 

the target answers:
•  Transfer - completes the transfer
•  Try Again - drops the current Transferee, and the call is available for an Attended Transfer to another 

listing.
•  Cancel - drops the current Transferee, and the Transferor is able to route the call as necessary.

•  Vmail Transfer** - places the call directly to the contact listing voicemail. 
Right click a Call History 
listing.

User right clicks a listing in the Call History and selects one of the options:
•  Dial - Place a call to the selected listing.
•  Intercom - Place an Intercom call to the selected listing.
•  Blind Transfer* - Selecting this option, the application immediately connects the two calls.
•  Attended Transfer* - Selecting this option, a second call listing displays in the Current Calls window. After 

the target answers:
•  Transfer - completes the transfer
•  Try Again - drops the current Transferee, and the call is available for an Attended Transfer to another 

listing.
•  Cancel - drops the current Transferee, and the Transferor is able to route the call as necessary.

Right click a Contact 
listing

User right clicks a listing in the Contact window and selects one of the options:
•  Favorite - Mark the contact as a preferred listing.
•  Dial - Place a call to the selected listing.
•  Intercom - Place an Intercom call to the selected listing.
•  Blind Transfer* - Selecting this option, the application immediately connects the two calls.
•  Attended Transfer* - Selecting this option, a second call listing displays in the Current Calls window. After 

the target answers:
•  Transfer - completes the transfer
•  Try Again - drops the current Transferee, and the call is available for an Attended Transfer to another 

listing.
•  Cancel - drops the current Transferee, and the Transferor is able to route the call as necessary.

•  VMail Transfer (Allworx Directory only) - places the call directly to the transferee’s voice mail box.
•  Details... (Outlook personal directory only) - the Contact Details window opens for the user to select the 

primary phone number. 
* The user interface guides the user to potential transfer targets.
** Available only to an Allworx Contact Listing.
866.ALLWORX * +1 585 421 3850 Page 43
www.allworx.com
Version: B Revised: March 8, 2017



Allworx Interact and Interact Professional Version 3.x User Guide
2. Place or receive a second call, the Current Calls window displays both calls. 

3. Click the More drop-down arrow, and select Conference from the drop-down list to join all 
callers. This connects both calls to a single, active call. The display shows both calls as in 
conference. 

Placing a call on hold temporarily removes the caller from the conference. To rejoin the 
conference, repeat step 3.

To end a conference call using the Interact Professional application:
In the Current Calls window, locate a call segment and click End Call. Select an option from the 
drop-down list:

End This Call Disconnects the specific active call participating in the conference call, and the active call no longer 
displays in the Current Calls window. The other active call(s) in the conference remain active, and 
the Current Calls window remains open. 

End Conference Disconnects all active calls participating in the conference call. The window closes – unless it is 
pinned open.

Continue without me Disconnects the Interact Professional user from the conference call while enabling the other callers 
to continue their conversation. After selecting the Continue without me option, the status of the 
active calls in the Current Calls window updates to Calls Connected, and then the window closes 
(unless it is pinned open). 

The Interact Professional application does not support this feature on four-way conference calls.
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6.6 Dialpad
Use the Dialpad window to place a phone call instead of using the phone dialpad. 

To place a call using the dialpad:
1. Open the Allworx Interact Professional Dialpad window

2. Dial the number using one of the following options:

• Dial the internal extension.
• Follow the dial plan for an external number. To dial an external number, dial the outside 

line access digit set in the dial plan (usually 9 or 78 + Allworx pin code).
• Immediate line seizure example: 9# or 78 + pin code# > Call > phone number 
• Call connect example: 9 <phone number> or 78 + pin code <phone number> 
• Right-click on the dialpad entry field and select one of the drop-down options.

3. Click the Call active call icon to place the call. The dialpad is available to dial additional digits 
while on a call (example: Auto Attendant options or PIN entry for the Message Center) without 
needing to press the Call active icon.

Shortcut: Double-click the Call action icon to redial the last number.

Hide Window Active Icon

Call Active Icon

Dialing Display Field
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6.7 Outside Lines
The Outside Lines window provides visual indication of which outside phone lines are in use and is only 
available if the Interact Professional user has an outside line assigned to the handset. Use the Outside 
Lines window to answer incoming calls, seize a line for outgoing calls, drag-drop an external contact or 
listing from the Contacts or Call History window to place a call. 

Use this window to place an call or answer a call. 

To place a call:
A red highlighted phone line option indicates that the line is unavailable.

1. Open the Outside Lines window.

2. Select one of the following options:

3. Use the Current Calls window to further manage the call.

To answer a call:
1. Open the Outside Lines window.

2. Click the red, blinking phone line.

3. Use the Current Calls window to further manage the call.

Option 1 Option 2

1.  Click on an available phone line. 
2.  Locate the Dialpad window. Enter the number and click 

Call.

1.  Locate the Contacts or Call History window, and then locate 
the external contact.

2.  Drag and drop the contact to an available line in the 
Outside Lines window.

Available outside phone line.
Blinking, red lines are ringing.

Solid, red lines are unavailable.

Hide Window Icon
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6.8 Parked Calls
The Parked Calls window displays a status listing of each parked call. Each status listing displays the 
Parking Orbit number, the caller wait duration, and the caller ID name and number.

Use this window to park or retrieve active calls.

To park a call in the Allworx Interact Professional application:
Do one of the following:

• Drag and drop the call listing in the Current Calls window to the Parked Calls window. 
• Locate the Current Calls Window, and then the current phone call. Click the More drop-down 

arrow, and select Park from the drop-down list. 

To return to the call:
Do one of the following:

• Click the call park listing Retrieve button.
• Double-click the call park listing.

Hide Window Icon

Call Park Listing
•  Caller image, if available
•  Parking Orbit Number
•  Caller ID Name 
•  Caller ID Number
•  Call Park Duration

Retrieve Button
866.ALLWORX * +1 585 421 3850 Page 47
www.allworx.com
Version: B Revised: March 8, 2017



Allworx Interact and Interact Professional Version 3.x User Guide
6.9 Queue Status
The Queue Status window displays the Call Queue and ACD Queue information when the Interact 
Professional user is a supervisor or agent of the queue, and/or has a Ring All PFK assigned to the 
handset. Additionally, the Queue Status window provides a shortcut to the Allworx View application.

To identify the Queue Line information:
All information is available to the queue agent. For Ring-All queues only: the window displays all 
information except Agents Logged In. The Queue Line provides the following information:

To identify the Agent Status information:
Only the queue supervisor can see this information. Click the arrow to the left of the queue description 
to display the information.

To access View:
Access detailed Allworx phone system data and usage reporting. Click the Launch Allworx View… 
button to open the View application in the default web browser window, and then manage the View 
application as defined in the Allworx View Application User’s Guide. If the Launch Allworx View... option 
is unavailable, the Interact Professional application periodically checks for View availability.

Queue Description* Name of the queue.
Queue Distribution Mode* Identifies the calls distribution method:

Agents Logged In Identifies the number of logged in agents in the queue.
Longest Wait Time* Period of time the oldest waiting call is in the queue.
Calls in Queue* Identifies the number of unanswered calls waiting in the queue.

Agent Displays the agents assigned to the queue.
State Identifies agent status.
Reason Identifies the agent busy state.
Duration Identifies the amount of time the agent in the current state except for the logged out state.
Active Queues Identifies the queue when the agent is currently handling a call.

Agent Status
Information

Queue
Information

Hide Window 
Icon

Shortcut to 
Allworx View

•  Ring All •  Linear Priority
•  Sequential Round Robin •  Fairness - Longest Idle
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Chapter 7  Interact Sync
Interact Sync is a customizable plug-in that enables click-to-dial capabilities between Interact 
Professional and installed versions of Lync 2013, Skype for Business 2015 or 2016, and Microsoft 
Outlook 2010, 2013, and 2016 applications as well as Google Chrome and Mozilla Firefox web 
browsers. Additionally, Interact Sync supports synchronization between Allworx Presence and Lync or 
Skype for Business Availability, Microsoft Outlook meetings, and the Allworx phone. When manually 
changing a presence or Availability status in one application, the other application synchronizes the 
status. To customize the Interact Sync feature, see “Update the Options” on page 24.

When manually selecting a Lync or Skype for Business Availability or an Interact Professional Presence 
setting, the applications synchronize and display the respective settings:

7.1 Set Interact Sync as the Default Dialing Application 
While installing the Interact Sync application, the following occurs on the Windows operating system:

Windows 7/8
• If there is already a default TEL protocol handler, Interact Sync does not register as the default 

TEL protocol during installation. To register the Interact Sync plug-in as the Windows default 
dialing application on the PC:
• Click Start > Control Panel > Default Programs.
• Click Set your default programs. 
• Locate and click Allworx Interact Sync > Choose defaults for this program. 
• Check the box next to TEL, and then click Save. The Windows operating system saves the 

changes.
• If there is not a default TEL protocol handler, the operating system registers the Interact Sync 

application as the default TEL protocol handler during installation. 

Windows 10
After installing the Interact Sync application, the Windows 10 operating system displays a pop-up 
message asking the user to select the TEL protocol handler to use when performing a TEL function. 

Interact Professional Presence Lync or Skype for Business Availability
In office Available
Busy Busy
(Unaffected) Do Not Disturb
Away Be Right Back
At Home Off Work
Away Appear Away
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To use the TEL protocol:
Perform one of the following:

• Executing a TEL protocol from the Windows Run dialog box.
• Click the PC Start icon.
• Locate the search field, type RUN in the field, and hit enter. The RUN window opens.
• Type tel: <phone number> in the field, and then click OK. The Allworx phone 

connected to the Interact Professional application automatically dials the number.

• Double-click a Windows shortcut that points to a TEL protocol.
• Locate the Windows shortcut and double-click.
• Locate the <type> Document tab. Verify the number is correct and click OK. The Allworx 

phone connected to the Interact Professional application automatically dials the number.

• Supports the TEL protocol if the web page supports TEL protocol.
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7.2 Click-to-dial with Google Chrome or Mozilla Firefox 
Web Browser

Easily click-to-dial a phone number on a Google Chrome or Mozilla Firefox web page using Interact 
Professional and an Allworx desk phone. Interact Professional users can navigate to a web page, click a 
phone number to dial, and automatically send a call from the Allworx handset connected to the 
Interact Professional application. 

To select the number to dial:
Select one of the following options:

• Click the enabled Allworx logo, and then select a detected number in the drop-down list. If 
Interact Sync does not detect any phone numbers, the Allworx logo is disabled. Examples below 
are from Mozilla Firefox web browser (Google Chrome browser displays the Allworx logo in the 
URL Address bar).

• Place the cursor over the phone number listed on the web page – the cursor changes from an 
arrow to a hand. Click the number.

Phone number detected No phone number detected
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• Highlight and right-click the phone number on the web page. 

To disable Interact Sync within the Mozilla Firefox web browser:
Click the Open menu > Add-ons Manager > Extensions > Allworx Interact Sync for Firefox > 
Disable.

To disable Interact Sync within the Google Chrome web browser:
Click the Open menu > Settings > Extensions > Allworx Interact Sync for Chrome > uncheck the 
Enable box.

7.3 Click-to-dial with Microsoft Outlook
Click-to-dial a Microsoft Outlook 2010, 2013, or 2016 contact with the Interact Professional application 
and a connected Allworx desk phone.

Interact Professional users can right-click any Outlook contact > Allworx dial... to see the available 
phone number information (except FAX numbers). After selecting a phone number, the Interact 
Professional application automatically sends a call from the connected Allworx handset to the Outlook 
contact.

The Allworx dial… menu is available in the following Outlook screens: 
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• People tab > Contacts List (2 options)

• Email > To… field

7.4 Presence Synchronization with Microsoft Outlook
Easily synchronize Allworx Presence with Outlook calendar appointments.

When creating or modifying an Outlook appointment, the Set Default Presence setting in the Outlook 
tool bar enables selecting an Allworx Presence setting for an appointment. The Allworx Presence status 
automatically updates through Interact Professional for the duration of the appointment, and then 

Option 1
1. Right click the contact.
2. Click Allworx dial…
3. Click the contact phone number to dial.

Option 2
1. Click the ellipsis for more options.
2. Click Allworx dial…
3. Click the contact phone number to dial.

1. Right click the email addressee.
2. Click Allworx dial…
3. Click the contact phone number to dial.
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restores to the original value once the appointment is finished. The Allworx Presence changes to the 
pre-appointment state after exiting the Interact Professional application. 

When the Allworx Presence setting is not set for an appointment or is explicitly set to use the default 
setting, the user’s Allworx Presence status updates to the default value for the duration of the 
appointment. Users can configure the Allworx Presence value in the Interact Sync options screen in 
Interact Professional or by selecting the default Presence in Outlook.

Users can also modify an Allworx Presence based on the “Show As” value for the given appointment. 
The Show As value of an appointment maps to an Allworx Presence according to the following:

Outlook “Show As” Value •  Free
•  Tentative

Working Elsewhere Busy Out of Office

Allworx Presence Value Does not change the user’s Presence On Business Trip At A Meeting Away

Use Default: displays a drop-down 
list to select which Allworx Presence 
setting to use while the meeting or 
appointment is in progress.

Allworx...:check the box to enable the 
synchronization. Use the drop-down 
list to select the default presence, and 
then click OK.
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Chapter 8  Troubleshooting

Condition Description Solution
Installation
Interact application 
provides “Could not 
access VBScript runtime 
for custom action” error 
message.

McAfee anti-virus is interfering 
with the installation of the 
Allworx Interact Professional 
application.

User must do a complete removal of McAfee anti-virus, using the 
MCPR.exe tool. 
1.  Navigate to Start > Control Panel > Programs and Features.
2.  Locate the McAfee software, and click the Uninstall button at the 

top of the list.
3.  Download the MCPR.exe tool from http://download.macafee.com/

products/licensed/cust_support_patches/MCPR.exe.
4.  Run the tool.
5.  Download Microsoft Fixit 50842.msi from http://go.microsoft.com/

?linkid=9804433.
6.  Run the tool.
7.  Reboot the computer.
8.  Install the Allworx Interact Professional software.
Note: The Allworx Interact Professional application requires an 
additional uninstallation and re-installation.

Some pre-requisites 
could not be installed 
error message displays 
and the .NET 4.5.1 
Framework fails to install.

The .NET 4.5.1 Framework 
installation requires 
Administrative privileges. 

Contact the Windows Administrator to install the .NET 4.5.1 Framework.

Warning message during 
the Interact application 
uninstall process.

In Windows, users can install 
Interact for multiple user 
accounts.

Click Continue to un-install the Allworx Interact Professional 
application. This does not affect other installations of the Interact 
application.

The current Interact 
application version level 
does not match the 
Control Panel > Programs 
and Features > Uninstall 
or change a program 
version level after 
upgrading the 
application.

Control Panel > Programs and 
Features > Uninstall or change 
a program page reports the 
application installed version, 
not the upgraded version.

The Windows uninstaller works without regard to version level reported 
in the control Panel > Programs and Features > Install or change a 
program page.

During install the 
following message 
displays: You do not have 
sufficient privileges to 
complete this installation 
for all users of the 
machine. Log on as 
administrator and retry 
this installation.

Insufficient PC privileges to install 
Interact Sync.

Interact continues to install. The Interact Sync application and features 
are unavailable.

User must run Interact Sync installer as administrator. Interact Sync 
installer is located at: %localappdata%\Allworx\Interact\<current 
version>\InstallInteractSync.exe.
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Login
Receiving a Windows 
Security Alert dialog 
window when clicking the 
Find Server IP button.

Windows users with limited 
privileges are clicking the Find 
Server IP button, and the firewall 
exception for the application may 
not exist. 

Click OK to close the Windows Security Alert dialog window. 
To add the Allworx Server IP:
•  Ask the Allworx administrator the IP address of the server, and enter 

the IP address manually.
•  Ask the Allworx administrator to add a firewall exception on the 

workstation for the Interact Professional application.
The Interact application 
detects an upgrade is 
available, but user sees 
an error message when 
attempting to upgrade.

The Interact application detected 
an upgrade.

Exit the application by clicking the icon in the Windows System Tray, 
and click exit. Restart the application.

The Interact application 
feature does not work as 
described.

The Interact application 
features are missing or don’t 
work properly.

Verify the Interact application is the latest version.

Password failure The Interact application does 
not accept the newly changed 
password.

The new password or PIN does not meet the Allworx System Software 
requirements. Contact the Allworx administrator for the password/PIN 
requirements.

Messages
Message displays: 
Communication with 
phone has been lost. 
Attempting to reconnect.

The Interact application has lost 
contact with the phone and is 
attempting to reconnect.

Verify the following connections:
•  Phone
•  Computer
•  Network activity
Verify phone is not rebooting.
If the Allworx administrator rebooted the phones, restart the Interact or 
Interact Professional application.

Message displays: 
Reconnecting with the 
phone.

The Interact application 
connection to phone was lost, 
and is actively attempting to 
reconnect.

Verify the following connections:
•  Phone
•  Computer
•  Network activity
Verify phone is not rebooting.

Message displays: Not 
receiving audio. Contact 
your system 
administrator.

While recording, no incoming 
data was received. May indicate 
a firewall issue.

Verify the firewall on the PC enables the Interact application as an 
exception. Contact the system administrator.

Message displays: The 
recording directory file 
system is full. Recording 
has been stopped.

The call recording storage 
directory has no more storage 
space available.

Move or delete older call recording files or designate a new location to 
store call recording files. See “Begin talking using the designated 
Allworx handset, and then click End Call when finished.” on page 23 for 
more information.

Manage Calls
Cannot place a call on an 
outside line.

Cannot access an outside 
phone line.

Dial the outside line access digit set in your dial plan - usually “9” or 
“78+PIN code”. 
If this does not work, verify with the Allworx administrator the outside 
line access information based on the Dialing Plan External Call access.

Current active call drops 
when selecting Dial or 
Intercom features.

Handset not configured to 
automatically place the current 
call on hold so that user may 
place another call.

Configure the Allworx handset. On the handset, navigate to CONFIG > 
Preferences > Auto On Hold. Select Enabled and exit the handset 
configuration menu. 

Condition Description Solution
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The Intercom Call option 
does not work.

The 9202E model Allworx phone 
does not support Intercom Calls.

The 9202E model Allworx phone does not support Intercom Calls.

Selected Interact contact 
does not dial correctly.

Interact Professional user selected 
an Interact contact to dial with a 
local number that requires dialing 
an area code.

The Allworx Administrator must add the local area code into the 
Allworx server dial plan, but the Allworx server strips the “9 + 1” from 
the entered phone number.

The Allworx Administrator must configure the Allworx server so that 
the send digits as dialed on the outside line is disabled.

Windows
The undocked Parked 
Calls window is empty.

The undocked Parked Calls 
window does not populate after 
selecting More > Park or when 
doing a drag and drop.

Verify with the Windows Administrator that the Interact Professional 
application is on the same network as the handset and network routing 
is consistent.

Not all the windows 
display in the Interact 
Professional. 

The Visible Windows setting 
was changed.

The user may not have server 
permissions to display certain 
windows.

Navigate to Settings > Visible Windows and select the windows to 
display.

Verify the correct permissions to view active system calls. Also, the 
outside lines window does not display if the her does not have any 
outside lines defined for the handset.

Cannot find the personal 
contacts in the Contact 
window.

Outlook Interact contacts do 
not display in the Interact 
Professional Contact window. 

The Interact Professional application requires the Outlook 2010 
application to be open prior to launching the application.
1.  Close the Interact Professional application.
2.  Launch the Outlook 2010 application.
3.  Restart the Interact Professional application.
The Outlook contacts are now available within the Interact Professional 
application.

Agent is in an unknown 
state.

The agent logged out of the 
Interact application while the 
application was in a hibernate, 
sleep, or screen lock state.

Restart the Interact application.

Interact Sync
Interact Sync is not 
working.

The Interact Professional 
application is not synchronizing 
with the Lync or Skype for Business 
application.

The Interact Sync application requires Microsoft Lync 2013 or Skype for 
Business 2015 or 2016 application to be running. Interact Sync does not 
work with earlier versions of Lync or Skype for Business.

The Interact Professional 
presence setting is not 
synchronizing properly.

The synchronization between 
the Lync/Skype for Business 
application and the Interact 
Professional application is not 
updating properly.

Do the following:
•  Check the Lync/Skype for Business client is updating properly.
•  Verify the Interact Sync feature key and application are installed.
•  Check the settings in Settings > Options > Interact Sync.
•  Shutdown Lync/Skype for Business and Interact Professional, and 

then restart in the following order:
•  Lync/Skype for Business
•  Interact Professional

The Interact Professional 
presence does not 
change per the Outlook 
calendar.

The Lync/Skype for Business 
application does not synchronize 
with the Outlook calendar 
availability, which synchronizes 
with the Interact Professional 
presence setting. 

Do the following:
•  Schedule meetings in advance. 
•  Check the Lync/Skype for Business client is updating properly.

Condition Description Solution
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The Allworx Presence is 
not changing with the 
Outlook appointments.

The Outlook calendar is not 
syncing the Allworx Presence.

Check the following settings available at Interact Professional > Interact 
Sync and verify:
•  The Presence Synchronizations options check box is enabled 

(checked).
•  The Override options are not enabled (unchecked) - e.g., On 

Vacation, On Business Trip, or At Home.
•  The Appointments and Allworx Presence > Default Presence for 

calendar appointments: is set to the "Show As" based option.
•  The Appointments and Allworx Presence > Do not modify my 

presence for appointments with a "Show as" value of:overrides are 
not enabled (unchecked) - Free or Tentative.

The Outlook welcome 
screen displays.

User does not have an Outlook 
profile and does not expect to see 
this screen.

Interact Professional automatically retrieves contacts from Microsoft 
Outlook, regardless if there has never been an Outlook profile created. 

Miscellaneous
The Interact application 
does not respond. When 
starting Task Manager, 
the application does not 
display in the 
Applications tab.

Only running applications with 
a sustained window showing 
display in the Task Manager 
Applications list. 

1.  Open the Task Manager and click the Processes tab. 
2.  Locate InteractStartup.exe and right click on it. 
3.  Click End Process to close the application.
4.  Re-launch the Interact application.

The font does not look 
crisp.

Windows XP users may experience 
bit mapped fonts 
within the Interact Application.

1.  Navigate to the computer desktop and right-click on the desktop. 
Select Properties from the drop-down menu. The Display Properties 
control panel box displays.

2.  Click the Appearance tab, and then the Effects... button.
3.  Click the check box “Use the following method to smooth edges of 

screen fonts”.
4.  Click the drop-down arrow and select Cleartype. 
5.  Click OK, and then click Apply, and then click OK to save the 

changes.
The recording directory 
no longer exists. Please 
check the file system.

The call recording storage 
directory is not available.

Verify the directory is still available or designate another location to 
store the call recording files. See “Begin talking using the designated 
Allworx handset, and then click End Call when finished.” on page 23 for 
more information. 

Cannot find the Launch 
Allworx View... button.

The Launch Allworx View... 
button is not available in the 
Queue status window, the 
Device Status Options 
drop-down list, or the System 
Tray options.

The Launch Allworx View... button is unavailable until the Allworx 
administrator installs the View CDR feature key and establishes a 
connection between the Allworx server and the View server.

Interact is unable to validate the default View application link.

Condition Description Solution
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